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Guarantee and liability 

Information in this publication is subject to change without prior notice. GAMMA Medizinisch-
wissenschaftliche Fortbildungs-GmbH makes no warranty of any kind. GAMMA reserves the express 
right to change this documentation without notification to any other party.  

GAMMA cannot rule out that through system-, service-, or user-error, defective evaluations may be 
calculated. Therefore, a plausibility check of the displayed data and calculations must be carried out 
by the patient’s doctor. The final decisions on treatment and the responsibility for the patient always 
rests with the attending physician. GAMMA accepts no liability. 

 

 

© Copyright 2010 
GAMMA Medizinisch-wissenschaftliche Fortbildungs-GmbH 

This document contains information protected by copyright. All rights reserved. No part of this document may be duplicated, 
reproduced or translated into other languages without the express written permission of GAMMA Medizinisch-wissenschaftliche 
Fortbildungs-GmbH. 

®, ™ Trademarks and Brand Names 

SAM is a registered trademark of the company SAM Präzisionstechnik, Germany. Microsoft and Windows are trademarks of the 
Microsoft Corporation, USA. Artex is trademark of the company AmannGirrbach GmbH, Germany. Denar and Hanau are trade-
makrs of the company Firma Waterpik Ltd., USA. KaVo is trademark of the company KaVo Kaltenbach & Voith GmbH & Co. 
Germany. Panadent is trademark of the company Panadent, USA. WhipMix is trademark of the company WhipMix Corp., USA. 
Gamma, Gamma Dental Software and CADIAX are trademarks of the company GAMMA Medizinisch-wissenschaftliche Fort-
bildungs-GmbH, Austria. Stratos is trademark of the company Ivoclar Vivadent AG, Liechtenstein. 

All of the products and product names mentioned in this handbook are brand names of the respective companies. The absence 
of the symbols ® and/or ™ does not imply that the name is an unprotected brand name. 



CADIAX® compact 2 

6 

 



1. Contents 

7 

1 Contents 

1 Contents...................................................................................................................................7 

2 Introduction ..............................................................................................................................9 
2.1 Important safety considerations ...............................................................................................9 
2.1.1 General safety instructions: .....................................................................................................9 
2.1.2 Special information about medical electrical devices ............................................................10 
2.1.3 Contraindications-limitations to application............................................................................11 
2.1.4 CADIAX® Magnet-Sensor system..........................................................................................12 
2.2 Explanation of symbols used on the packaging and the device: ...........................................12 
2.3 Appropriate application ..........................................................................................................13 
2.4 About these operating instructions ........................................................................................13 
2.4.1 Symbols and notations...........................................................................................................13 
2.5 Scope of delivery ...................................................................................................................14 
2.5.1 Required accessories, not included in the scope of delivery.................................................15 
2.5.2 Optional accessories..............................................................................................................15 
2.6 Computer system requirements.............................................................................................15 

3 Preparing to operate CADIAX® compact 2 ............................................................................17 
3.1 Installing the CADIAX® compact 2 Software..........................................................................17 
3.2 Basic settings in CADIAX® compact 2 Software....................................................................20 
3.2.1 Starting the Software .............................................................................................................20 
3.2.2 Setting the facebow ...............................................................................................................21 
3.2.3 Setting the articulator programming.......................................................................................21 
3.3 Preparing the facebow...........................................................................................................22 

4 Recording TMJ movement.....................................................................................................23 
4.1 Preparations...........................................................................................................................23 
4.2 Fixing the clutch onto the lower jaw teeth..............................................................................24 
4.2.1 Fixing the occlusal tray clutch onto the lower jaw teeth:........................................................24 
4.2.2 Fixing the para-occlusal clutch onto the lower jaw teeth .......................................................25 
4.3 Mounting the anatomical upper facebow...............................................................................26 
4.4 Mounting the writing bow and adjusting the writing tips to the anatomical axis ....................28 
4.5 Attaching the measuring flags and styli .................................................................................30 
4.6 Recording joint track curves...................................................................................................31 
4.7 Registration of CPM...............................................................................................................37 
4.8 Ending registration/saving data..............................................................................................39 

5 Data evaluation ......................................................................................................................41 
5.1 Retrieval and analysis of recordings......................................................................................41 
5.2 Retrieval and analysis of the CPM.........................................................................................42 
5.3 Value settings for the articulator ............................................................................................42 
5.4 Data printout...........................................................................................................................44 

6 Individual settings ..................................................................................................................47 
6.1 The File menu ........................................................................................................................47 
6.2 The Edit menu........................................................................................................................47 
6.3 The View menu ......................................................................................................................48 
6.4 The Settings menu.................................................................................................................48 
6.4.1 Facebow.................................................................................................................................49 
6.4.2 Articulator ...............................................................................................................................49 
6.4.3 Recording...............................................................................................................................50 
6.4.4 Sound.....................................................................................................................................50 



CADIAX® compact 2 

8 

6.4.5 Function keys ........................................................................................................................ 51 
6.4.6 Colors & Fonts....................................................................................................................... 51 
6.4.7 Color & line depth of the curves ............................................................................................ 51 
6.4.8 Cursor.................................................................................................................................... 52 
6.4.9 Coordinate system ................................................................................................................ 52 
6.5 The Help menu...................................................................................................................... 52 

7 Additional information............................................................................................................ 53 
7.1 The Reference Coordinate system ....................................................................................... 53 
7.2 Mounting the articulator......................................................................................................... 54 
7.3 ISS Threshold........................................................................................................................ 57 

8 Troubleshooting..................................................................................................................... 59 

9 Specifications ........................................................................................................................ 63 
9.1 Technical Data ...................................................................................................................... 63 
9.2 Cleaning ................................................................................................................................ 63 
9.2.1 CADIAX® compact 2 Device.................................................................................................. 63 
9.2.2 Measuring flags: .................................................................................................................... 63 
9.2.3 Measuring stylus: .................................................................................................................. 64 
9.3 Recurrent tests ...................................................................................................................... 64 
9.4 Operating conditions ............................................................................................................. 64 
9.5 Storage and Transport .......................................................................................................... 64 
9.6 Guidance and manufacturer’s declaration Electromagnetic compatibility ............................ 65 
9.6.1 Electromagnetic emission ..................................................................................................... 65 
9.6.2 Electromagnetic immunity ..................................................................................................... 65 
9.6.3 Recommended separation distances between portable and mobile RF communications 

equipment and the CADIAX® compact 2.............................................................................. 67 
9.7 Disposal................................................................................................................................. 67 



2. Introduction 

9 

2 Introduction 

Thank you for showing your confidence in us by purchasing the CADIAX®
 compact 2. You have pur-

chased a top-quality medical-technical product, the result of more than 20 years of experience in the 
electronic registration of joint tracks (TMJ). In the following pages, we would like to help you get ac-
quainted with the CADIAX®

 compact 2 and its software. 

2.1 Important safety considerations 

 

For your own safety, as well as for operational safety, please read these instructions thor-
oughly, before beginning to operate the device. Always comply with any and all warnings 
included in these instructions, and/or on the device itself. 

2.1.1 General safety instructions: 

 

The device must be operated in a roomy area, in order to allow for proper dissipation of 
heat. 

Never operate the device in areas, where there is a danger of water seeping into the ma-
chine. 

The device is powered from a computer connection, through a Universal Serial Bus (USB). 
Only connect the device directly to a computer’s USB terminal. Only connect the device 
directly to a computer’s USB jack. Never operate the device through a USB hub. Never use 
alternative power sources of any kind. 

Never set up the system in the proximity of potential fields of electromagnetic interference 
(loudspeakers, mobile phones, sterilizers, etc.). 

Never attempt to repair the device yourself. All repair work must be done by authorized, 
trained technicians. 

In case of the following, disconnect the device from the computer, and contact a qualified, 
service technician: 
• If water or other liquid seeps into the device. 
• If the device does not operate properly, although the operating instructions have been 

followed correctly. 
• If the device is dropped, or falls, or the housing is damaged. 
• If the device shows noticeable deviation from its normal operation. 

Please make sure that the device is set up on a smooth, even surface, which is longer and 
wider than the device itself. 

The surface on which the device stands must be sufficiently stable, as the machine could 
be badly damaged by shaking or falling. 

In choosing the working area and/or storage area, make sure that the device is not subject 
to extreme deviations in temperature or humidity, as well as to direct sunlight and exces-
sive heat. 

Make sure that the device is not subjected to vibrations and jolts. 
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Also make sure that the cable does not pose a hindrance (e.g., to be stumbled over). 

2.1.2 Special information about medical electrical devices 

2.1.2.1 Setting up the CADIAX® compact 2  

 

If the computer being used to power the CADIAX®

compact 2 is in the proximity of the patient, it must be 
tested, in compliance with standard EN 60601-1. 

If the computer powering the CADIIAX® compact 2
has not been built according to standard EN 60601-1, 
it must be set up at a distance from the patient, or the 
computer, including any devices connected to it (e.g., 
monitor) must be connected to the power source 
through an isolation transformer. 

The patient’s proximity is the area within which the 
patient could, intentionally or unintentionally, come 
into contact with any parts of the medical electrical 
device or system, or in contact with someone using or 
touching part of the device or system. 
(Definition according to Standard EN 60601-1) 

1,5 m1,5 m

2,
5 

m

 
 

1,
5 

m

 
Definition of patient proximity, according to 

Standard EN 6060601-1-1 
 The CADIAX®

 compact 2 may not be operated in the direct proximity of other devices, or 
stacked with other devices. If it does become necessary to operate the CADIAX®

 compact 
2 in the proximity of other devices, or stacked with other devices, please make sure to ob-
serve the device carefully, to ensure its correct operation in this system configuration. 

2.1.2.2 Operating the CADIAX® compact 2  

 

Only switch on the recording mode, after the measuring sensors (flags and styli) are com-
pletely mounted. 

During the registration, do not touch the flags or styli. This also applies to the patient. 

Always switch off the recording mode, before detaching the flags and styli from the face-
bow. 
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2.1.2.3 Electromagnetic compatibility 

 

Medical electrical devices require special safety precautions, with regard to electromag-
netic tolerance. Therefore, the CADIAX®

 compact 2 may only be installed and put into op-
eration according to the instructions contained in chapter 9.6 of this handbook. 

Only use accessories which are explicitly approved for the CADIAX® compact 2. Using 
other accessories, especially cables which are longer than the cable lengths prescribed in 
this user’s manual, can lead to the emission of interferences, or to reduced interference 
immunity in the CADIAX® compact 2. 

Portable and mobile HF-communication appliances, e.g., mobile telephones, cordless tele-
phones, computers, and laptops with activated WLAN, etc., can have detrimental effects on 
medical electrical devices. Do not operate CADIAX®

 compact 2 in the proximity of these 
potential sources of interference, and make sure to adhere to the safe distances described 
in  9.4 of this handbook. 

2.1.2.4 Connecting other devices 

 

Devices connected to analog or digital interfaces must be certified to satisfy the applicable 
standard EN specifications (e.g., EN 60950 for data-processing devices, or EN 60601 for
medical electrical devices). In addition, all configurations must satisfy system standard EN 
60601-1-1. Whoever connects supplementary devices to the signal input or outlet units is 
the system configurer, and responsible for ensuring that system standard EN 60601-1-1 is 
adhered to. 

2.1.3 Contraindications-limitations to application 

 
 

 

When operating the CADIAX compact 2, the following conditions can hinder or limit its ap-
plication: 
• Cognitive abilities: 

Patients who are not able to follow or carry out the attending dentist’s instructions cor-
rectly (e.g., where to move the lower jaw, etc.), for physical or psychological reasons  

• General clinical pictures: 
Patients with illnesses, which do not allow for the attachment of a facebow for registra-
tion purposes. Illnesses may be physical or psychological in nature (e.g., spastic, epi-
lepsy, claustrophobia, injury or disease of the skull or soft-tissue structures of the 
skull, or ears, etc.). 

• Dental clinical picture: 
Patients with odontopathy or periodontal disease, which excludes the mounting of a 
clutch (parodontosis, loose teeth, damage to the tooth substance, changes in the mu-
cous membranes in the mouth or pharynx, etc.). 

• Certain diseases in the ear region. 
Patients with diseases in the ear region (e.g., painful inflammations, tinnitus, ear pain, 
etc.). 

• Patients with extreme muscle pain in the head and neck region are not able to wear 
the facebow for the duration of the examination. 

• Patients between 0 and 9 years of age. Children are first able to follow the dentist’s 
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instructions well enough to lead to a successful examination from about 10 years of 
age onwards. In addition, existent deciduous teeth can make it difficult to fix the clutch. 

• Patients with active implants (e.g., heart pacemakers) should be handled cautiously, 
as the stylus tip, to which a magnet is attached, could come into proximity of such im-
plants. 

2.1.4 CADIAX
®
 Magnet-Sensor system 

 

The CADIAX® Magnet-Sensor system (“M“-Sensor) contains a magnet in the tip of the 
stylus. For this reason, special care is necessary, when using the CADIAX® "M" Sensor
system with patients with pacemakers or implanted defibrillators! Make absolutely sure to 
adhere to the necessary safe distances. If necessary, consult the handling cardiologist. If in 
doubt, refrain from using the CADIAX® "M" Sensor system. 

2.2 Explanation of symbols used on the packaging and the device: 

 
ATTENTION: see accompanying instructions 

 
ATTENTION: magnetic field 

 
Type B applied part 

    

Follow user’s instructions 

    

Manufacturer 

SNSNSNSN     Serial number 

 

Dispose of separately from other waste mate-
rial 

 
Connection for flag and stylus, right 

 
Connection for flag and stylus, left  

 
Connection for Universal Serial Bus (USB) 

 
Connection for foot switch 
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2.3 Appropriate application 

The CADIAX® compact 2 System is designed for registration and display of hinge axis movements of 
the human mandible, conversion of these movements into an intercondylar distance, determined 
through the articulator, and calculating the settings for an articulator, appropriate to the patient.  

The system is used by dentists and dental technicians. 

2.4 About these operating instructions 

The authors of this handbook assume that the reader has a basic knowledge of condylography, work-
ing with a facebow, and the transfer of head-related data into an articulator.   

In addition, a sound basis in the Microsoft Windows operational system is required. The user should 
be able to work with the user-interfaces, and other operational elements of the Windows programs. 

This handbook is not a substitute for a basic education in using the Windows operating system. If you 
have only little or no education in Windows, we recommend that you first become acquainted with the 
system. This will make it much easier to work with the CADIAX®

 compact 2 software. 

2.4.1 Symbols and notations 

The following symbols and notations will be used in this handbook to describe certain commands and 
instructions: 
• Designations of keys will be written in italics. For combinations of keys, plus signs (+) will be in-

cluded. 

e.g.: CTRL+D means: hold down the Control key, then press the D key 
 

• Menu items in CADIAX® compact 2 software are displayed in italics. If several menu items need 
to be selected in succession, they will be linked with arrows (�). 

e.g.: File � Close means: first, click on the File menu item, then click on the menu item 
Close, in the open menu. 

Special attention will be called to important aspects with the following symbols:: 

 
Attention 

This symbol points to a possible source of error, or the danger of possible 
operational error. 

 
Info 

Here, you will find especially important additional information, regarding the 
theme being described. 

 
Tip Useful Tips und Tricks, for working with CADIAX® compact 2. 
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2.5 Scope of delivery 

When you receive your CADIAX® compact 2 system, check the package contents, for quality of deliv-
ery. 

The following items are included in the CADIAX® compact 2 basic system (Article No. 01-10D200-2 + 
03-SOFTD000CC2 + 06-230430 + 06-230451) scope of delivery: 

 

 

CADIAX® compact 2 device  

 

2 measuring flags (1) 

 

Foot switch (1)  

 

2 measuring styli (1) 

 

USB Cable, 
Length 3 m 

   

 

Upper facebow (1) (2)  

 

Lower facebow (1) (2) 

 

Retaining strap for the up-
per facebow (1) (2) 

 

 

Occlusal clutch (small) (1) (2) 

 

Axis locator pins 
(2 pieces) (1) 

 

 

AB bow-adapter for two fixing 
screws (1) (3) 

   

 

Screwdriver for fixing the AB 
bow-adapter (1) (3) 

 CD-ROM with CADIAX® 
compact 2 software 

  This operation manual 

(1) These units are not included in the scope of delivery of the CADIAX® compact 2 Upgrade  
(Article No. 01-SP0060 or 01-SP0061) 

(2) These units are not included in the scope of delivery of the CADIAX® compact 2 system  
(Article No. 01-10D200-2) 

(3) In the CADIAX® compact 2 basic system (Article No. 01-10D200-2 + 03-SOFTD000CC2 + 06-
230430 + 06-230451) the AB bow adapters are already mounted. In this case the screwdriver 
is not necessary and not in scope of delivery. 
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Before using the system, the AB-Bow adapters must be screwed onto the Reference 
AB Bow. The measuring flags will then be fixed to these parts, whereby the bore for 
the fixing screw (the hole with the depression) must face forward! 

 
Computers or laptops, necessary for operating the CADIAX® compact 2 System, are not in-
cluded in the scope of delivery. 

2.5.1 Required accessories, not included in the scope of delivery  

The following accessories are required for working with CADIAX® compact 2, but are not included in 
the delivery package of the CADIAX® compact 2 System. 

 

 Bite registration material 
for fixing the occlusal 
clutch 

  Dispenser for applying the 
bite registration material in 
the occlusal clutch 

 
Use exclusively a silicone adhesive, with a Shore-hardness of maximum A 60. 
Follow the manufacturer’s directions! 

2.5.2 Optional accessories 

The following accessories are optional. They serve to expand the possible applications of the 
CADIAX® compact 2 System: 

 

 

Para-occlusal Track) 
(Article No. 06-230345) 

 ESPE Protemp for fixing 
the para-occlusal clutch 

 

Occlusal clutch (small) 
(Article No. 06-230335) 

 GAMMA Dental Software 

Please contact your local distributor for further information. 

2.6 Computer system requirements 

A computer is required, in order to use the CADIAX® compact 2 System. The CADIAX® compact 2 
Software runs on the following operation systems: 

• Windows® 2000 
• Windows® XP Home 
• Windows® XP Professional 

The minimum computer system requirements are: 



CADIAX® compact 2 

16 

• Sufficient main memory on hand, according to the configuration and the software in-
stalled. 

• At least 100 MB of free hard disk space is recommended. 
• CD-ROM drive. 
• One free USB interface on the Computer. 

 
Do not operate the CADIAX® compact 2 over a USB hub. Sufficient power for trouble-free 
operation of the device is only guaranteed through a direct connection to a computer inter-
face. 

A screen appropriate for use at the dental chair is required. Please note here, that the distance be-
tween the user and the screen can be greater than when using normal computer applications. 
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3 Preparing to operate CADIAX® compact 2 

Before beginning to work with the CADIAX® compact 2 System, several preparatory steps must be 
carried out. 

3.1 Installing the CADIAX® compact 2 Software 

To install the CADIAX® compact 2 Software, insert the CD-ROM into the computer’s CD-ROM drive. 
The installation program will start automatically, after a few seconds. 

 
Before connecting the CADIAX® compact 2 with the computer the first time, first install the 
CADIAX® compact 2 Software. The installation program for the CADIAX® compact 2 Soft-
ware also installs the appropriate drives for the CADIAX® compact 2 device. Only then, can 
the computer’s operational system recognize the CADIAX® compact 2 when it is connected. 
This also applies, even if GAMMA Dental Software is already installed on your computer. 

 

 

After placing the CD ROM into the computer, this 
menu appears. Here you have several possibilities: 
• Install  CADIAX® compact 2 Recorder Software. 
• Read the operating instructions directly onto the 

PC and/or print them out 
Install the Adobe Acrobat software, which you need, 
in order to read the operating instructions on the 
computer. 

 

When you install CADIAX® compact 2 Recorder 
Software, you will first be directed to select the lan-
guage in which you want to work on the software. 
The language for the software can be changed at 
any time, after installation. 
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Click on Next> to start the installation procedure. 

 

Please read through the conditions in the license 
contract carefully. If you accept the license contract, 
mark this in the corresponding place, and continue 
the installation, by clicking on the Next> button. 
If you do not accept the license contract, please 
discontinue the installation of the CADIAX® compact 
2 Software. 

 

In the next step, you will be asked which directory 
the program data should be copied in. 
The standard installation directory is: 
C:\Programme\Gamma Dental\CADIAX® 2 Re-
corder. 
Only change this as much as necessity demands. 
Start the installation of the CADIAX® compact 2 
Software, by clicking on the Install button. 
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The Installation program copies only the necessary 
data onto your computer. 

 

Installation of the software is now completed. 
 

 

The CADIAX® compact 2 Software is now opera-
tional. Before you finally complete the installation 
and start the CADIAX® compact 2 Recorder Soft-
ware, connect the CADIAX® compact 2 to a free 
USB jack on your computer. The operating system 
now undertakes the configuration of the drives. As 
soon as this procedure is completed, the CADIAX® 
compact 2 System is ready for operation. 

 

 
Do not operate the CADIAX® compact 2 over a USB hub. Sufficient power for trouble-free 
operation of the device is only guaranteed through a direct connection to a computer inter-
face. 

 
Use exclusively the USB cable, which is provided in the delivery package. 
Do not use either longer or unshielded USB cables. 
In these cases, the safe operation of the CADIAX® compact 2 device would not be guaran-
teed. 
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3.2 Basic settings in CADIAX® compact 2 Software 

After installation of the CADIAX® compact 2 Recorder Software, you must work on several settings. 
First, start up the CADIAX® compact 2 Recorder Software: 

 

 
It is not necessary that the CADIAX® compact 2 device is connected to the computer. 

3.2.1 Starting the Software 

CADIAX® compact 2 Recorder Software is started through the Windows® Start menu (All Programs � 

Gamma Dental � CADIAX
®
 compact 2) or through the  button on the computer desktop. 

After starting the program, the following screen appears: 

 

 
If you are already using GAMMA Dental Software, you should start the CADIAX® compact 2 
Software directly from the CADIAX® Analysis program. This has the advantage that the data 
will then be saved to the GAMMA databank automatically, and can then be used in all of the 
other parts of the program. 
If the CADIAX® compact 2 Recorder software is started from GAMMA Dental Software, the 
Graphics and Articulator buttons are not available, as these functions are integrated in the 
CADIAX Analysis software.  
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3.2.2 Setting the facebow 

Set the facebow type, which you use in your practice. You will find the selection of facebows in the 
menu: Settings � Facebows… . 

 

 
The various facebows have different scales for entering facebow width. If a wrong facebow 
is entered, the given facebow width will also not be correctly converted in the flag distance. 
This leads to a distorted picture of the recorded condylar tracks and, in some circum-
stances, to a falsification of the value settings for the articulator. 

3.2.3 Setting the articulator programming 

Now, please set the type of articulator, which you use in your practice. The selection of articulators is 
found in the menu: Settings � Articulator… . 

 

CADIAX® compact 2 supports the following types of articulators (in alphabetical order): 

 
Artex® AP / CP Artex® AR / CR Artex® TK / CN 
Artex® TR / CT Artex® SL Denar® Anamark 
Denar® D5A Denar® Mark II Hanau® 96H2 
Hanau® Modular Hanau® Wide Vue Ivoclar® Stratos 200 
Ivoclar® Stratos 300 KaVo® Protar Panadent® 
Reference A Reference I Reference SL 
SAM® WhipMix® 2240 WhipMix® 2340 
WhipMix® 3040 WhipMix® 3140 WhipMix® 8500 

In addition, you should determine whether you want the data output in tabular or in graphic form. 
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 Tabular display: Graphic display: 
  

 

 

 
The data output in graphic form is not available for all articulator types. 

 
If you want to save these settings as default values for further work, click on the control field 
“Save settings as default values “. 

3.3 Preparing the facebow 

 
This is only necessary if you are using the Reference AB Facebow. 

 

    

The AB-Bow-adapters must be screwed 
onto the Reference AB Bow, before using 
the system. The measuring flags will then 
be fixed onto these parts, whereby the 
bore for the fixing screw (the hole with the 
depression) must face forward! 
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4 Recording TMJ movement 

Basically, the registration of mandibular movement is always carried out in the following method: 

1. Preparations (see paragraph 4.1)  

2. Fixing the clutch to the lower jaw teeth (see paragraph 4.2, page 24) 

3. Mounting the anatomical upper facebow (see paragraph 4.3, page 26) 

4. Mounting the writing bow and adjusting the writing tips to the anatomical axis (see paragraph 
4.4, page 28) 

5. Measuring flags and measuring styli (see paragraph 4.5, page 30) 

6. Registration of joint track curves (see paragraph 4.6, page 32) 

7. Registration of CPM (see paragraph 4.7, page 37) 

8. Complete registration/ save data (see paragraph 4.8, page 39) 

4.1 Preparations 

Before you begin registration, get all of the necessary devices and materials ready and available. 
Start up the CADIAX® compact 2 Software on your computer and connect the CADIAX® compact 2 to 
your computer. 
The functions display on the front of the CADIAX® compact 2 will light up green, if the device is ready 
for operation. The status line on the CADIAX® compact 2 Software shows you whether a CADIAX® 
compact 2 device is connected to the computer. If either of these is not the case, you will find informa-
tion for error correction in chapter 8, page 61, under “Troubleshooting”.  

 
Do not operate the CADIAX® compact 2 over a USB hub. Sufficient power for trouble-free 
operation of the device is only guaranteed through a direct connection to a computer inter-
face. 

 
Use exclusively only the USB cables, provided in the delivery package.  
Do not use longer or unshielded USB cables. 
In these cases, the safe operation of CADIAX® compact 2 would not be guaranteed. 

 

Next, enter the patient data. There are input fields available, above the coordinates system, for given 
name, family name, date of birth, and gender. 

 
 

 
If the registration software is started from GAMMA Dental Software (CADIAX® Analysis 
program), the historical data will be displayed automatically. It is not possible to change 
data here. 
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4.2 Fixing the clutch onto the lower jaw teeth 

There are two different kinds of clutches available for attaching the lower face bow to the lower jaw. 
These are the occlusal-covering tray clutch (see paragraph 4.2.1), and the para-occlusal clutch (see 
paragraph 4.2.2). 

4.2.1 Fixing the occlusal tray clutch onto the lower jaw teeth: 

 
If you are using a para-occlusal clutch, you can skip this step, and begin reading paragraph 
4.2.2, “Fixing the para-occlusal clutch to the lower jaw teeth “ (page 25). 

When mounting the occlusal tray clutch, proceed as follows: 

 Before use, the clutch should be properly disinfected and/or sterilized, respectively, accord-
ing to hygienic instructions. 

 
Check whether the clamp on the lower face bow can be pushed up easily. If not, do not con-
tinue to use this clutch. 

 Select an appropriate clutch for the patient. There are two sizes available (small / large). 

 
Examine the periodontal status of the lower jaw dentition. In case of a poor periodontal 
situation, either refrain from using the clutch, or (the attending dentist’s responsibility), take 
suitable precautionary measures (e.g., blocking out). Areas of the dentition, undercut to the 
occlusal plane, should always be blocked out with appropriate material (e.g., soft wax), even 
with patients having a healthy periodontal status. 
If you fix the clutch to a provisionally cemented denture, the possibility arises, among others, 
that the denture can become loose, due to mechanical influences. In such cases, you must 
determine whether provisional cementing is appropriate or not. 

 
Use exclusively a silicone adhesive (bite registration material), with a Shore-hardness of 
maximum A 60. Follow the manufacturer’s instructions! 

 
Before introducing the silicone material, the clutch is inlayed with 3 thin rolls of soft wax (di-
ameter 3-4 mm). The rolls are attached at diagonals to the arch, one in the front, and two in 
the back. These provide natural breaking points, which will make removing the clutch much 
easier. 

 Fill the clutch to maximum 2/3 full, with the silicone material. 

 Place the filled clutch onto the lower jaw teeth. Set the shaft in a median-sagittal position. 
The patient draws back the lower jaw, and closes, thus automatically positioning the shaft, 
so that the smallest possible locked bite is achieved. 
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_   

     

 
Before mouinting the lower jaw writing bow, the silicone must be completely set, with the 
patient’s mouth slightly open. Follow the manufacturer’s instructions! As a control, we rec-
ommend that you check the material separately (extra-orally). Make sure that no interfer-
ences occur in the back areas, caused by material being squeezed out. If there are any 
such interferences, these should be removed. 

4.2.2 Fixing the para-occlusal clutch onto the lower jaw teeth 

 
If you are using the occlusal-covering tray clutch, you can skip this paragraph, and begin 
reading paragraph 4.3, “Mounting the anatomical upper facebow“ (page 27). 

Using a para-occlusal clutch allows you to analyze the effects of occlusion on the TMJ position, and 
hinge axis movement. Condylar Position Measurements (CPM) can be carried out directly in the 
patient’s mouth, so you no longer need to measure CPM on mounted casts. The para-occlusal 
clutch is located outside of the occlusion, so it doesn’t touch the upper jaw teeth, neither in intercus-
pation, nor in function. 

 
Check whether the clutch shaft fits in the lower facebow clamp, and if it can be moved 
freely. 

 Place the clutch in the patient’s mouth, and bend the wings until they lie on the lower tooth 
arch. Allow 1 mm of space between the teeth and the clutch, for the plastic. 

 Place a wax plate between the upper and lower teeth, and have the patient bite down. The 
wax plate prevents the plastic from flowing onto the upper teeth, and eliminates the tiresome 
job of having to polish the clutch’s plastic surface. 

 Use the 3-phase system, ESPE Protemp, as plastic material, with excess material on the 
catalyzer, to shorten the setting phase. 

 Coat the surface of the clutch, which should be facing the labial and buccal teeth, with a 2 
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mm thick layer of plastic. Wait until the material begins to set. 

 
Place the clutch in the patient’s mouth and instruct the patient to close, without allowing the 
upper teeth to touch the clutch (check this). 

 Wait until the material has set, then remove the clutch from the patient’s mouth. 

 
Remove any excess interferences of the plastic material, with a sharp knife or a cutter. Use 
as little plastic as possible. Too much plastic can often cause pain in the gums. 

 Check to see whether the clutch fits properly in the mouth. 

 
Occlusion paper marks the contacts between the clutch and upper jaw teeth, which must be 
removed. 

 
If the plastic has not completely set, you can lay the clutch aside, and begin mounting the 
upper facebow. 

 
Examine the periodontal status of the lower jaw dentition. In case of a poor periodontal 
situation, either refrain from using the clutch, or (the attending dentist’s responsibility), take 
suitable precautionary measures (e.g.: blocking out). Areas of the dentition undercut to the 
occlusal plane, should always be blocked out with appropriate material (e.g., soft wax), even 
with patients having a healthy periodontal status. 
If you fix the clutch to a provisionally cemented denture, the possibility arises, in some cir-
cumstances, that the denture can become loose, due to mechanical influences. In such 
cases, you must determine whether provisional cementing is appropriate or not. 

 Moisten each tooth impression in the clutch plastic with a thin layer of medical glue, appro-
priate for this purpose. A gel consistency is preferable to a liquid consistency.. 

 
Do not fix the para-occlusal clutch onto painful or loose teeth. 

 Place the clutch on the lower teeth, from gingival towards occlusal. The teeth should not be 
dried immediately before applying the glue. 

 Instruct the patient to take the maximum intercuspation position. As soon as the glue begins 
to absorb moisture, it hardens quickly. Press the clutch firmly onto the teeth for 30 seconds.  

 After the registration, the clutch can be removed easily. The teeth need only a light cleaning 
(scaling). The same plastic-coated clutch can be re-used for the same patient (glue residue 
need not necessarily be removed). 

4.3 Mounting the anatomical upper facebow 

 Pull back the glabella support. The retaining straps are fixed to the facebow. The bite fork 
base is not on the bow. 
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 The porus knobs of the anatomical facebow are placed into both ear canals. The patient can 
actively help here. The bow width is fixed on the front crossbar, with the aid of the clamp 
screws. 

 

  

 As the facebow is carefully closed, the porus knobs are guided into the ear canals. The 
comfortable, painless position is then fixed with the clamp screws. With moderate pressure, 
the glabella support is carefully pushed against the bridge of the nose, then lightly clamped. 

 

  

 The retaining straps are stretched on both sides, then closed behind the head and fastened 
with the Velcro fastener. The porus knobs should now tend to face dorsal to the ear canal, 
so that during excursive movements, the lateral condyle is not hindered. The facebow is 
checked, to see that it is attached comfortably and problem-free. If necessary, adjust the 
retaining straps and/or the glabella support. Eliminate rolls of skin under the glabella sup-
port, by pulling the forehead skin tight, then screwing in the support. 
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 A completely mounted upper facebow 

 

   

4.4 Mounting the writing bow and adjusting the writing tips to the anatomi-
cal axis 

 The upper facebow is mounted without electronic flags. 
The two axis locators are slipped into the bores of the left and right styli and clamped firmly. 

 The side arms of the lower face bow are pushed 
completely outwards, then attached lightly. 
The patient holds the lower jaw closed, in centric 
(retral) position. 
The double clamp is pushed onto the clutch. 
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The side arms are moved, so that the tips of the 
guide units slide into the bores on the upper 
facebow, which mark the anatomical axis point. 
This fixes the positions of the styli on the ana-
tomical axis, and also guarantees a correct dis-
tance to the flag.   
The patient (or an aide) lightly presses the 
guides inwards, on both sides.. 

 

  

 

 The writing bow is now adjusted so that it is parallel to the bow. Both fixing clamps of the 
side arms (right and left) are now carefully clamped firmly. 

 
The double clamp is pulled on carefully. 
It is important, that the double clamp is 
pulled on at the end, and not before clamp-
ing the two side arms! 

 

 
The axis locator pins for setting the anatomical 
axis are now removed. Make sure here, that the 
positions of the side arms don’t change.  

 

 The mounted lower facebow, set at the anatomical hinge axis point.  
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If there is a change in position, this means that the system is not mounted tension-free, or 
that one of the clamps is not fixed properly. The mounting procedure for the lower facebow 
must then be repeated. 
An improperly mounted lower facebow can lead to false registrations! 

4.5 Attaching the measuring flags and styli 

 The measuring flags are placed behind the side arms of the lower face bow and screwed 
firmly onto the facebow. 

 
Make sure not to soil or scratch the black surfaces of the flags.  
Also make sure that the recording mode is not switched on, while the flags and styli are 
being attached. 

 

  

 
The measuring styli are fixed into the bores of the lower face bow. 
They are pushed in to their hilts. The cable of the stylus should hang down after it is fixed in 
the bore. 
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 If the system is mounted properly, with the lower jaw in centric position, the stylus tip should 
be located in the area of the upper back quarter of the flag, approximately 7 mm distant from 
the upper and back edges of the black measuring surface on the flag.  
The short connecting cable is plugged into the free plug from the flag. 

 

  

 
The circuit between stylus and flag should remain closed, even when the system is disman-
tled after use, and the individual parts are stored in their packages. Improperly breaking the 
circuit could lead to faults or disturbances in the system, e.g., broken cables. 

 The flag cable is plugged into the CADIAX® 
compact 2. The flag mounted on the patient’s 
right side, is plugged into the plug designated 
right, the left flag into the plug labelled left. 

 

4.6 Recording joint track curves 

 Click on the Recording button. It changes color to red. The fields underneath also turn red. 
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Only switch on the CADIAX® compact 2 recording mode, after the measuring flags and 
measuring styli are completely mounted. Do not touch the flags or styli during the entire  
registration procedure. This also applies to the patients. 

 

 

 An input screen appears automatically, for definition of the flag distance (geometric input). 
Read the appropriate values from the front facebow scale in millimeters, and make any nec-
essary changes in the value on the screen. 

 

 
 

 
This value should be input as exactly as possible, so that after the registration, when the 
conversion to the condylar distance of the articulator is carried out, it will also be as exact as 
possible. Also make sure to input the data for right facebow type. 

 By pressing the Enter key, or activating the foot switch, the set value is accepted and the 
program skips automatically to the function, “Reference Point”.  
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 Guide the patient’s lower jaw into the reference 
position (joint centric) and acknowledge this 
position by pressing the Enter key, or by press-
ing the foot switch. A signal tone acknowledges 
the input and the field turns green on the screen. 

 

 
The chin-guiding technique shown here can be replaced by any other user-specific tech-
nique for achieving the centric position. 

 After successfully determining the reference position, you will be directed to select the 
curves, which you want to record next. Click on one of the twelve curve buttons, or the CPM 
button (if you want to carry out a condylar position measurement. 
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 The curve selected for registration appears on the screen in red background. Press the En-
ter-key or the foot switch to start recording the lower jaw movement. 

 

 

 The patient carries out the desired movement, e.g., Protrusion. The CADIAX® compact 2 
registers the movements for 4.5 seconds. A signal tone marks the beginning of the registra-
tion. 

 
If there is no signal tone, the acoustic signals in the CADIAX® compact 2 Recorder Software 
must be set, or the sound system of your computer must be reconfigured (see also para-
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graph 6.4.4, page 51). 

 

  

 

 

 The remaining time is displayed with a progress bar. The end of the recording is marked by 
a second signal tone. As soon as the registration is completed, the curve is displayed on the 
screen. 

 
The recorded curve must first be checked for its quality. Here, the start position of the curve 
should be examined, relative to the reference point (0 in the coordinate system), and the 
quality of the curve, in the sense of cleanness of the curve line. Registrations with apparent 
distortions should not be accepted; the flags and/or styli should be cleaned. Don’t let faulty 
recordings deter you (even after having cleaned the sensors); discontinue the registration 
and contact an authorized Gamma Service department.  
A curve registration contrary to the expected form needs to be analyzed and verified by fur-
ther registration. If necessary, the curve must be recorded again. 
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 If you press the Enter key or activate the foot switch, the next curve will be selected for reg-
istration. 

 
You can configure the examination process individually, i.e., you can determine the number 
and order of the movements to be recorded, individually  
(see paragraph6.4.3). 

 

  

 
Please note that the designation mediotrusion rright and mediotrusion left, always refer to 
the condyle which is making the mediotrusive movement at that particular time. 
This means that mediotrusion right is a mandibular movement (chin) to the left side and a 
mediotrusion left is a mandibular movement (chin) to the right side. 
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4.7 Registration of CPM 

The difference in the joint between the reference position (RP or RCP) and another, arbitrary joint 
position (e.g., max. intercuspation) is measured 3-dimensionally. 

As reference position (RP), the last position determined as reference position by the “Reference Posi-
tion” function is retrieved. 

10 registrations of CPMs are available to the user. These consist of 10 possible repetitions, from 
which an average (avg.) is taken as the measurement. We recommend also, that you re-determine the 
reference point before beginning a CPM. 

 

 
These measurements of a position, in relation to the occlusion (e.g., ICP), only make sense, 
if the registration clutch is fixed to the lower jaw teeth in the para-occlusal method. 

 After registration of the last joint track curve, the software can be switched to record mode of 
the electronic CPM (Condylar Position Measurement), with CADIAX® compact 2 . Initiate 
this by clicking on the CPM button. 
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 For the CPM measurement, the patient is guided to the position to be measured (in ICP, the 
patient bites the teeth together). Then shortly press the foot switch.  

 

 

� 

 

 RP � ICP 

 The device acknowledges the position with a signal tone. The recorded coordinate values 
will be entered into the appropriate free space in the list and the average will be calculated 
and entered in the Avg. section. 
This point registration can be repeated up to 10 times. 
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 The entered values are distance values, in 
mm, of the individual position, measured 
from the reference point. The values are 
relative to given spatial coordinates. 
Simultaneously, the CPM point will be 
marked in the graphics with blue crosshairs. 

 

4.8 Ending registration/saving data 

 
To end the registration, press the Record button again. The field returns to green and the 
screen shows the coordinate system without data display. 
Next, save the recorded data. CADIAX® compact 2 saves the data of every patient. The file 
name can be chosen arbitrarily. The program suggests a file name automatically, consisting 
of family name, given name, and the patient’s date of birth.  

 

 

 
Now, the measuring flags and the styli are removed from the facebow. Then, the facebow is 
removed from the clutch, and the clutch is then removed. 
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 Always switch off the recording mode, before you remove the flags and styli. 

 
Carefully move the shaft of the clutch up and down, to loosen it. When removing the clutch, 
make sure that it does not strike the upper jaw teeth. If necessary, the upper jaw teeth may 
need to be shielded (e.g., with a wax plate). 
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5 Data evaluation 

After the registration, the compiled data must be evaluated. For this purpose, the recorded curves are, 
on the one hand, displayed in different views on the screen. The curves can be measured in detail. An 
overlay display is possible, for comparison of different curves. On the other hand, value settings for 
various articulators can also be calculated from these recorded joint tracks. 

5.1 Retrieval and analysis of recordings 

When the registration process is ended, the data can be analyzed immediately. Data that has already 
been saved can be loaded again in the CADIAX® compact 2 Software. 

To display the curves in a graphic, the Graphics function must be switched on (displayed with green 
background on the screen). The curves are displayed  in the axis-orbital reference coordinate system. 

 

 

Click on the buttons for the various curves (Protrusion, Mediotrusion right, Mediotrusion left, 
Open/Close), and they are displayed. Click on the button again, and the curve is blended out. To be 
able to distinguish the individual curves, they are displayed in different colors. The color of the curve 
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corresponds to the color of the labeling in its corresponding field. The green point on the left, next to 
the curve buttons, shows whether data is saved there or not. If a field contains no curve data, the but-
ton is disabled. 

With the computer’s mouse, you can click on any arbitrary curve. The values of this curve position will 
be shown in the lower half of the values window,: 

• x, y, z: Spatial coordinates of the selected position 
• SCI: Sagittal condylar track inclination 
• TCI: Transversal condylar track inclination 
• s: Length of the condylar track, from the point of origin to the selected position 

The output is given separately for the right and left sides. 

5.2 Retrieval and analysis of the CPM 

To load the Condylar Position Measurement (CPM), click on the corresponding button. A table ap-
pears in the lower part of the screen, with the CPM measurement values. 

 

The given values are distance values, in mm, each according to its position, measured from the refer-
ence point. The values are relative to the given spatial coordinates. 

 

Simultaneously, the CPM point is marked with blue crosshairs. 

5.3 Value settings for the articulator 

Semi- or fully- adjustable articulators allow the user to fit the device, with its simulation of eccentric 
movement, to the actual movements of the lower jaw. For this purpose, we are able to set given guid-
ance tracks on the articulator in the two spatial planes (sagittal, transversal), which determine the 
movements, in their angularity to the reference plane, and/or select from various forms. We are refer-
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ring here to sagittal condylar inclination and characteristics (SCI, formerly HCI), and transversal condy-
lar inclination and characteristics (TCI, or Bennett).  

The curvatures of these inserts are modelled after the naturally occurring tracks, in order to achieve as 
exact a match as possible with the actual track. In order to be able to select a ruler with a correspond-
ing angle setting, the curve must be converted to the actual intercondylar distance of the articulator. 

Press the Articulator button, and CADIAX® compact 2 switches to the articulator programming func-
tion mode. The Articulator field is now displayed in green. 

In the basic setup, all recorded protrusion- and mediotrusion curves are loaded for calculating the 
articulator settings. Therefore, as in the picture shown above, all of the entries in this field have a 
green background. If several curves are registered, the articulator calculations will be made, based on 
an average value of the selected curves. Just click on the curve button to select or deselect a curve. 

 

The first table shows the raw data for protrusion, retrusion, and mediotrusion right/left. The information 
here is for documentation purposes, the values may NOT be used in programming the articulator.  

Articulator settings tables: 

 

The CADIAX® compact 2 program searches for the best-fitting curve form, with corresponding angular-
ity. Various distances are taken into consideration. If the articulator selected has various guidance 
inserts available,  with distinguishable characteristics, then an optimal insert will be calculated for each 
curve. The insert which corresponds most closely to the actual registration will be displayed in bold 
print and marked with a point. 

• SCI: Indicates the table for the sagittal condylar track guidance 
• TCI: Indicates the table for the transversal condylar track guidance 
• Insert: Describes the curve characteristics which are most similar to the individ-

ual patient’s registration. 
• Angle: Indicates the rotation of this insert to the reference plane (setting accord-

ing to the scale on the articulator) 
• 3 mm, 5 mm, 10 mm: Indicates up to which number of millimeters the selected condylography 

curve for the calculation has been used. 
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As an alternative to the tabular display of the articulator value settings, a graphic display is also possi-
ble. 

 

 

 

 

 

 

 

 

 
The graph display of articulator value settings is not available for all articulators. 

5.4 Data printout 

The CADIAX® compact 2 Software allows the user to printout a standard sheet, containing all of the 
patient-relevant data from the condylography. Printing is done with your Windows® printer.  

The printout shows the registered curves in graphic form, and the setting values for a selected articu-
lator. 
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6 Individual settings 

6.1 The File menu 

In the File menu, you will find all of the functions necessary for processing the data recorded with the 
CADIAX® compact 2 System. 

New prepares for the next registration. If a previous recording 
has not been saved, the program will inform you, so that no pa-
tient data will be lost. 

Öpen loads an eyxisting file withi CADIAX® compact 2 data, 
enabling you to modify and/or evaluate the registrations. 

Save secures the CADIAX® compact 2 registrations to the com-
puter’s hard disk. If the data to be saved does not have a name, 
you will be directed to supply one.  

Save as secures the data under a new file name.  

Print  prints out the selected data. 

View presents a preview of the printout, i.e., how the data will 
appear in the printout. 

Printer allows you to select and configure the printer to be used 
for the printout. 

Export/Import enables the import and/or export of data in the 
SCII and XML formats.  

In the next section of the File menu, you will see a list of the 
most recently processed files. Click on any one of these, to load 
it into the program. 

 

Exit ends the program 

6.2 The Edit menu 

Cut removes the marked entries and stores the information in 
the Windows Clipboard for possible use in other programs. This 
function is only available for the patient data in the header. 

Copy places the marked entries on the Windows Clipboard, for 
possible use with other programs. This function is only available 
for the patient data in the header.  

Insert takes the information from the Windows Clipboard and 
insert it into the marked location. This function is only available 
for the patient data in the header. 
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View Copy makes the current view of the condylography curves 
on the Windows Clipboard available to the other programs as a 
graphic. 

6.3 The View menu 

Icon bar fades in and fades out the icons. 

Status bar  fades in and fades out the status bar. 

Large Symbols displays large or small icons. 

Expanded Display also displays the vertical plane (y/z), in addi-
tion to the sagittal plane (x/z) and the transversal plane (x/y). 

Coordinate values fades in or fades out the inscriptions on the 
coordinate system. 

 

Zoom settings determines the display size of the coordinate 
system. 

6.4 The Settings menu 

Facebow allows you to set the facebow to be used (see para-
graph  6.4.1, page 49) 

Articulator allows for the setting of the articulator to be used  
(see paragraph 6.4.1, page 49) 

Record enables the individual adaptation of the examination 
procedure (see paragraph  6.4.3, page 50) 

Sound allows you to set individual acoustic signals. (see para-
graph 6.4.4, page 50) 

Assign Function Key enables the individual assignment of 
program functions to particular keys (see paragraph 6.4.5, page 
51) 

Colors & Fonts allows for the individual setting of fonts, font 
size, and color, for an optimal adaptation of the CADIAX® com-
pact 2 Program (see paragraph 6.4.6, page 51) 

 

Color & Line Depth of the curves enables individual setting of 
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the line depth and color of the condylography curves, for optimal 
adaptation of the CADIAX® compact 2 Program (see paragraph  
6.4.7, page 51) 

Cursor allows for the individual setting of form, color, and size of 
the various cursors used in the program, for optimal adaptation 
of the CADIAX® compact 2 Program (see paragraph 6.4.8, page 
52) 

Show Cursor for Real-time Display shows the current stylus 
position (cursor) during the registration, or fades it out. 

Coordinate system allows you to chang the inscriptions on the 
coordinate axes (see paragraph  6.4.9, page 52) 

Language activates a different language for the program. The 
program will then have to be re-started. 

6.4.1 Facebow 

 
 

Here you can choose the facebow to use for the registration. 

 
Different facebows have varying scales for input of facebow width. If a false facebow is en-
tered, the given facebow width will not be converted correctly in the flag distance. This leads 
to a distorted display of the recorded condylar tracks and, in certain circumstances, to falsi-
fication of the value settings for the articulator. 

6.4.2 Articulator 

 

Here you can select the articulator, which you use in your prac-
tice. The recorded condylography curves will be converted to 
value settings for the chosen articulator, so that the articulator 
can reproduce the recorded movement as closely as mechani-
cally possible. 

Now you need to input the ISS Threshold, if the chosen articula-
tor also allows for setting the immediate sideshift (ISS). For more 
information regarding the ISS Threshold, see paragraph 7.3, 
page 60. 

The articulator value settings can be presented in either tabular 
or graphic form (see paragraph 5.3, page 42). 
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The options selected here will be saved with the data from the 
condylography curves. If you also want to use these settings for 
further registrations, mark the option: Save these settings as 
default for new objects, before closing the window. 

6.4.3 Recording 

 

Here, you have the possibility to individually determine the ex-
amination procedure. If the option, Select next recording auto-
matically, is marked, all of the movements marked in the 
accompanying list will be loaded. Otherwise, you would need to 
select each movement to be recorded manually.   

Mark the items in the list, which should be recorded in the auto-
matic examination procedure. You can change the order of the 
movements to be recorded by using the two arrow keys. 

If a reference point needs to be newly determined, before a reg-
istration, press the New reference point before recording button. 
The corresponding item will be marked  with a »« symbol.. 

6.4.4 Sound 

 

CADIAX® compact 2 uses your computer's sound system for 
acoustic signals. Here, you have the possibility of determining 
the individuual tone signals for the various events in the CADI-
AX® compact 2 Recorder Software. Mark the appropriate event, 
then select any sound file you like, which should be played when 
the event takes place. The sound file must be available in  WAV 
format. 

Please also check the settings on your computert's sound sys-
tem. 
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6.4.5 Function keys 

 

Here, you have the possibility of individually assigning the pro-
gram functions to keys. 

Mark the program function, and select the desired key or key 
combination, which should carry out the particular function. Mul-
tiple key assignment is also possible. 

6.4.6 Colors & Fonts 

 

Here, you can individually modify the graphics user interface of 
your CADIAX® compact 2 Recorder Software   

From the list, select the section of the program interface which 
you want to modify. Now, you can individually modify the color-
coding, font size and color of this section. 

6.4.7 Color & line depth of the curves 

 

Here, you can adapt the displays of the condylography curves, 
individually. 

Select a curve, and assign the color and depth of line. 
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6.4.8 Cursor 

 

Here, you can individually adapt the size, color, and the appear-
ance of the cursor. 

Select a cursor type, and assign ist color, size, form and depth of 
line. 

6.4.9 Coordinate system 

 

Since the names of the coordinate axes are not administered 
uniformly, you have the possibility here, of adapting the names 
of the axes, as well as the positive number direction to corre-
spond to your own nomenclature. 

6.5 The Help menu 

 

Info supplies you with information regarding the installed version 
of CADIAX® compact 2 Recorder Software 
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7 Additional information  

The CADIAX® compact 2 System is an arbitrary registration system, i.e., it is based on an anatomic 
facebow. By using an anatomic facebow, it is predetermined, that the system measures exclusively 
movements from an averaged hinge axis, dependent upon the patient's ear canal. A measuring me-
thod near the joint is carried out. 

The advantage of an arbitrary measurement lies in the ease of setting the measuring styli onto a pre-
determined anatomic hinge axis point. The mechanical system defines the hinge axis point exactly, 
relative to the ear canal, and is easily adjustable. 

The compromise of arbitrary measurement is also valid; in the TMJ  movements relevant for articulator 
progrmming (protrusion and mediotrusion), normally a very slight rotational movement occurs, which 
distorts the curve characteristic.  

In the same vein, for further definition of the hinge axis orbital plane, an average anterior reference 
point ("orbital point") is selected, relative to the glabella support. 

7.1 The Reference Coordinate system 

For the registration of reproducible TMJ movements, a reference coordinate system was introduced, 
which makes it possible to  carry out a standardized conversion in the articulator. This coordinate sys-
tem is designated the "hinge axis-orbital coordinate system". 

 

The origin of the coordinate system lies in the mid-
dle, between the condyles, at a point where the 
hinge axis, at the zero position (centric), intersects 
with the median-sagittal plane. From this coordinate 
origin, the positive x-axis goes forwards, the positive 
z-axis goes downwards, and the positive y-axis goes 
to the right (from the patient's viewpoint). 
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Coordinate system with sagittal and transversal view 

The graphic display above left, depicts the Benett 
movement, or transversal movement of the right 
condyle (in the graphic, the x-axis is oriented hori-
zontally, the y-axis, vertically)- The graphic display 
underneath, shows the sagittal plane, subdivided into 
points, one millimeter apart, whereby the x-axis is 
oriented horiizontally, and the z-axis, vertically. 

The graphic display in the upper right section depicts 
the Bennett movement, or transversal movement of 
the left condyle (on the screen, the x-axis is oriented 
horizontally, the y-axis vertically). The graphic un-
derneath shows the sagittal plane, whereby, in the 
graphic, the x-axis is oriented horizontally, the z-axis 
vertically. 

The origin of all graphic displays is the Reference 
position, which is determined through the corre-
sponding Reference point function. The curves are 
not always congruent with the origin of the coordi-
nate system. 

The above sections of both Bennett coordinate sys-
tems are oriented to medial (positive Bennett move-
ment, according to the former standard), and 
describe the transversal shift of the hinge axis. The 
sagittal coordinate systems are oriented to the front, 
and point to the middle of the of the graphic. 

 
Extended coordinate system with 

sagittal, transversal and frontal view 

7.2 Mounting the articulator 

All of the calculations of the CADIAX® compact 2 System are given in a reference coordinate system. 
This coordinate system is defined by the (statistical) right and left hinge axis points, and a third, ante-
rior reference point. These 3 points describe a reference plane, the hinge axis-orbital plane. 

 

The anterior reference point of the hinge axis-orbital plane is established by a fixed, predetermined 
distance of 22 mm of the nasion-support, to an imaginary middle line of the side arms of the facebow. 
If this reference plane is transferred in the articulator, the diagram would look like this: 
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Now, if the upper jaw model is transferred to the articulator, with the same facebow, the calculated 
values will match the actual settings of the condylar housing of the articulator. 

Facebow transfer of the upper jaw is optional. 
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If you are using a different facebow for transfer, make sure that the facebow is set to the same refer-
ence points. Only then can you be sure that the calculated values from CADIAX® compact 2 will match 
with the transferred model situation in the articulator.  

Model transfer with an exact transfer bow 

Basically, the transfer can be made in the following way: 

The reference points of the GAMMA bow (right and left hinge axis points, plus the anterior reference 
point) are marked on the patient. Then, using the facebow from the articulator system, the transfer of 
the upper jaw is carried out, relative to these marks on the patient's skin. 

Marking the anterior reference point is only done on one side (patient's left side), at the side of the 
bridge of the nose, or under the eye. Measure a distance of 22 mm from the deepest depression of the 
nasion and mark it. Transferral of the hinge axis point is best carried oute after the registration, using 
the writing bow, which is still set up, whereby, the the anatomic bow is dismantled and the skin marked 
with a pen (axis pin), through the bore (stylus holders). 

 Model transfer with the anatomic transfer bow: 

The anatomic transfer bows from various manufacturers differ somewhat, both in their measurements, 
as well as in their methods of use in mounting models. The limitations and characteristics of their con-
struction necessitate using different methods of transferring the reference plane, but also different 
locations of the reference plane, relative to the nasion point. If we assume, that the statistically ac-
cepted hinge axis points hold the same position, or that the difference lies within a tolerably small 
range, then we arrive at the following tables of mounting and/or conversion recommendations, respec-
tively, for using the various anatomic facebows: 

 

Articulator Anatomic Bow  TCI SCI 

Artex® Direct mounting in the Artex® Articula-
tor, Reference facebow upgrade with 
axis pins 

Calculations are set 
directly 

Calculations are set 
directly lt 

Denar® Mounting with Denar® Slidematic face-
bow, adjustment of the bow on the 
anterior mark on the skin with the or-
bital pointer 

Calculations are set 
directly 

Calculations are set 
directly 

Hanau® Mounting with Hanau® Slidematic 
facebow, adjustment of the bow on the 
anterior mark on the skin and orbital 
pointer 

Calculations are set 
directly 

Calculations are set 
directly 

Ivoclar® Mounting using Ivoclar® UTS (Univer-
sal Transfer bow System), Reference 
plane determined by means of anterior 
mark on skin and orbital pointer 

Calculations are set 
directly 

Calculations are set 
directly 

KaVo® Direct mounting in KaVo® Articulator, 
Reference facebow upgrade wth axis 
pins (Girrbach Art. Number 230491). 
required accessory: KaVo Extraneous 
bow reference 

Calculations are set 
directly 

Calculations are set 
directly 
Scale: Frankfurter 
Horizontal 
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Articulator Anatomic Bow  TCI SCI 

Panadent® Mounting using  Panadent® facebow Calculations are set 
directly 

Calculations are set 
directly 

Reference® Direct mounting in the  Artex® Articula-
tor, Reference facebow upgrade with 
axis pins (Girrbach Art. Number 
230491) 

Calculations are set 
directly 

Calculations are set 
directly 

SAM® Mounting with SAM® ATB facebow Calculations are set 
directly 

Subtract 2 degrees 
from the given SCI 
table values, the 
calculation of the 
fossa characteristic 
remains unchanged   

WhipMix®  Mounting with WhipMix anatomic face-
bow 

Calculations are set 
directly 

Calculations are set 
directly 

7.3 ISS Threshold 

The ISS Threshold (ISS = Imediate Sideshift) divides the measured curve into two parts (see 
graphic). The initial part is necessary for calculating the ISS, the second section, for calculating the 
PSS (Progressive Sideshift) or TCI (Transversal Condylar track Inclination 

 



CADIAX® compact 2 

58 
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8 Troubleshooting 

There are always two steps involved in correcting errors in the CADIAX® compact 2 System: first, 
determine what the problem is, then carry out the recommended solution to eliminate the error. 

If errors occur, which are not covered in this chapter, you must contact an authorized GAMMA service 
outlet, to solve the problem. 

 

The device functions, but the green LED on the front is unlit. 

Possible cause Solution 

The device is not connected to 
the computer. 

Connect the device with a USB terminal on your computer. 

The USB interface of the oom-
puter is defective. 

Have the computer checked; if necessary, use another com-
puter. 

The CADIAX® compact 2 is con-
nected to the computer through a 
USB hub. 

Connect the device directly with a USB terminal on your com-
puter. 

 

The CADIAX® Recorder Software can't respond to the device. 
The message keeps appearing, that the registration cannot be continued, even thoughe the 
device is connected. 

Possible cause Solution 

The device is not connected to 
the computer. 

Connect the device with a USB terminal on your computer. 

CADIAX® compact 2 drive is not 
installed, or not installed properly. 

Re-install the CADIAX® compact 2 drive. 

 Disconnect the CADIAX® compact 2 from the computer and 
plug it in again. Wait until the device is completely recognized, 
then press the Record button.  
 
If the device is still unresponsive, shut down the software, and 
disconnect it from the CADIAX® compact 2; then, plug it in 
again, re-start the software, and press the Record button.  
 
Finally, you can restart the CADIAX® compact 2; wait until the 
operating system is completely running up, then start the soft-
ware, and press the Record button.  

 

When I mount the styli, their positions are outside the black measuring surface areas of the 
flags. 

Possible cause Solution 

The patient's lower jaw was not in 
the reference position, when the 
writing bow was set at the statisti-
cal hinge axis point.  

Repeat the procedure of setting up the writing bow, according 
to the directions. The patient should keep the lower jaw closed, 
in centric position (= reference position). 
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When I mount the styli, their positions are outside the black measuring surface areas of the 
flags. 

Possible cause Solution 

The fixing clamps of the writing 
bow are not firmly in place. 

Make sure, that the bow's holding clamps are firmly in place, 
both on the shaft of the clutch, and on the side arms. Additional 
stress from the styli can cause a certain amount of shifting. 

The writing bow was not adjusted 
properly, to be free of tension. 

When mounting and setting the writing bow, make sure that 
there is no tension in the system. The bow must not be allowed 
to shift, especially when pulling out the adjustment bolts. 

 

The system is mounted, but one of the function displays (right/left) indicates an error . 

Possible cause Solution 

The stylus is not connected. Make sure that the short stylus cable is plugged into the ap-
propriate flag connector. 

The flag is not connected. Check that the flag is plugged into the CADIAX® compact 2 
device. 

The stylus is not in the proper 
measuring field of the flags. 

An error may have occurred during the mounting procedure, so 
that the stylus tip is not in the appopriate measuring field of the 
flag, i.e., the entire black measuring surface. 
Here, you must also pay attention to the working side (move-
ment towards the back), during the mediotrusion movement. 

The flag is soiled. Due to the flag being soiled, no electrical contact is possible 
between the tip of the measuring stylus and the flag. Clean the 
flag, according to the directions for maintenance. 

The stylus is defective. Contact your local dealer, or contact GAMMA directly. 

The flag is defective. Contact your local dealer, or contact GAMMA directly. 

The CADIAX® compact 2 device 
is defective. 

Contact your local dealer, or contact GAMMA directly. 

 

The recorded curves go "backwards", instead of to protrusive. 

Possible cause Solution 

The right and left measuring sys-
tems are reversed. 

An error has been made, by connecting the right measuring 
system, to the left flag plug on the CADIAX® compact 2 device, 
and vice-versa. Correctly replace the plugs, and repeat the 
registration. 

 

The recorded curves display strong artifacts. 

Possible cause Solution 

The flags are soiled. Because the flags are soiled, there is no electrical contact be-
tween the stylus tip and the flag. Clean the flag, following the 
directions for maintenance. 



8. Troubleshootin 

61 

The recorded curves display strong artifacts. 

Possible cause Solution 

The stylus is not in the measuring 
of the flags. 

An error has occurred in mounting , so that the stylus tip is not 
in the permissable measuring range of the flag, i.e., the entire 
black surface. 
Here, it is important to observe the working side (movement 
towards the back), during mediotrusive movements. 

"Sliding chair effect" A so-called "sliding chair effect" can sometimes come about, 
by the stylus moving across the flat surface of the flag: the 
stylus hops up shortly from the flag surface, as the stylus 
"skips" across the flag. If a measurement happens to be read, 
during one of these "hops", this could result in artifacts show-
ing up on the registration. The sliding chair effect is accompa-
nied by a distinctive squeaking sound. To minimize the effect, 
you can apply a tiny amount of medical vaseline to the flag 
surface. After the registration, the flag must be cleaned again. 

The stylus is defective. Contact an authorized GAMMA service outlet, or GAMMA di-
rectly. 

The flag is defective. 
Contact an authorized GAMMA service outlet, or GAMMA di-
rectly. 

The CADIAX® compact 2  device 
is defective. Contact an authorized GAMMA service outlet, or GAMMA di-

rectly. 

 

The recorded curves do not begin in the coordinate origin. 

Possible cause Solution 

The reference point is displaced. The reference point must be re-determined. Do this with the 
Reference Point button. 
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9 Specifications 

9.1 Technical Data 

Measuring resolution  ADC: 14 Bit 

Measurement data display: 0,01 mm 

Deviation of linearity: ± 5% 

Supply voltage: 5 V = (only through USB Bus from the PC) 

Current input: max. 0,5 A (in compliance with USB specifications) 

Protection class: B 

 

9.2 Cleaning 

9.2.1 CADIAX
®
 compact 2 Device 

Make sure that the device is turned off, and disconnect from the computer. The CADIAX® compact 2 
electronics may not be connected. 

Remove dust and dirt with a soft cloth. 

 

 
Do not use liquid, and make sure that no liquid gets inside the device during cleaning. The 
device must never be cleaned under running water, or any other liquid. Do not use stiff 
brushes or steel wool. 

 
Never clean the device with alcohol, organic solvents, or disinfectants, as these may cause 
damage to the components and the housing. 

9.2.2 Measuring flags: 

The flag surface must not be damaged (e.g., scratched) or soiled (oil, dust, fingerprints, etc.). Check 
the condition of the flag surface before every application. 

The flag surface must be cleaned, from time to time, whereby the measuring surface should be wiped 
off with rubbing alcohol. The flag should then be patted dry, with a soft, lint-free cloth, and left out to 
dry completely. During cleaning, make sure that the sensitive surface of the flag is not damaged.  

 

 
Never treat or clean the flags with stiff brushes or other "scratchy" material. 
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9.2.3 Measuring stylus: 

The stylus may only be wiped off with a dry, lint-free cloth. The tips can be cleaned, when necessary, 
with rubbing alcohol. 

 

 
Never handle or treat the sockets and the axes with oil, or any other lubricants. 

9.3 Recurrent tests 

Like all other electronic devices, CADIAX® compact 2 and its electronic components also go through 
the aging process. Therefore, the device must be tested at regular intervals, in regard to its measuring 
technology and its security technology. We recommend an interval of one year. 

The security testing should be carried out in compliance with standards DIN VDE 0751-1 ("Recurrent 
tests and tests before placing in operation of medical electrical equipment or systems, Part 1: General 
Specifications"), standard ÖNORM/ÖVE E 8751-1 ("Recurrent tests and test after maintenance of 
medical electrical equipment, Part 1: General requirements"), or IEC 62353 ("Medical electrical e-
quipment - Recurrent tests and test after repair of medical electrical equipment“.  

The recurrent tests measure any differences in potential between the touchable, conductive elements 
of the connector assembly. Any difference in potential which appears, indicates faulty security tech-
nology, which must be corrected. These measurements are carried out as supplementary to the re-
quired standard tests above. 

Measurment technology testing will be carried out by GAMMA, or an authorized GAMMA service out-
let. 

The measuring flags are subjected to relatively high mechanical stresses, and undergo the results of 
normal wear and tear. They should be replaced after approximately 500 examinations. 

9.4 Operating conditions 

The device is designed for operation exclusively in dry areas. 
• Temperature range: +15 bis + 35 degrees Celsius 
• Relative humidityt: maximum 85 %, non-condensing 

In case of a drastic change in temperature, wait until the device has reached room temperature, be-
fore beginning operation. 

9.5 Storage and Transport 

If the device is to be transported over long distances, return the device, completely packed, to its ori-
ginal carton.riginalkarton. 

For storage and transport, please comply with the following conditions: 
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• Temperature: -10°C - +60°C 
• LHumidity:max. 85% - store in a dry place 
• Pressure:0 hPa - 1060 hPa 

9.6 Guidance and manufacturer’s declaration 
Electromagnetic compatibility 

9.6.1 Electromagnetic emission 

The CADIAX® compact 2 is intended for use in the electromagnetic environment specified below.  
The customer or the user of the CADIAX® compact 2 should assure that it is used in such an envi-
ronment. 

Emission test Compliance  Electromagnetic environment - guidance  

RF emissions 
CISPR 11 

Group 1 The CADIAX® compact 2 uses RF energy only for its internal 
function. Therefore, its RF emissions are very low and are not 
likely to cause any interference in nearby electronic equipment. 

RF emissions 
CISPR 11 

Class B 

Harmonic emissions 
IEC 61000-3-2 

Not applicable 

Voltage fluctuations/flicker emis-
sions 
IEC 61000-3-3 

Not applicable 

The CADIAX® compact 2 is suitable for use in all establishments, 
including domestic establishments and those directly connected 
to the public low-voltage power supply network that supplies 
buildings used for domestic purposes. 
 
The CADIAX® compact 2 is suitable for use in all establishments 
other than domestic and those directly connected to the public 
low-voltage power supply network that supplies buildings used for 
domestic purposes. 

9.6.2 Electromagnetic immunity 

The CADIAX® compact 2 is intended for use in the electromagnetic environment specified below.  
The customer or the user of the CADIAX® compact 2 should assure that it is used in such an envi-
ronment. 

Immunity test IEC 60601 test level Compliance level Electromagnetic environment -  
guidance 

Electrostatic discharge IEC 
61000-4-2 

± 6 kV contact 
± 8 kV air 

± 6 kV contact 
± 8 kV air 

Floors should be wood, concrete or 
ceramic tile. If floors are covered 
with synthetic material, the relative 
humidity should be at least 30 %. 

Electrical fast tran-
sient/burst 
IEC 61000-4-4 

± 2 kV for power supply 
lines 
± 1 kV for input/output 
lines 

± 1 kV for input/output 
lines 

Mains power quality should be that 
of a typical commercial or hospital 
environment. 

Surge 
IEC 61000-4-5 

± 1 kV differential mode 
± 2 kV common mode 

Not applicable Mains power quality should be that 
of a typical commercial or hospital 
environment. 

Voltage dips, short interrup-
tions and voltage variations 
on power supply input lines 
IEC 61000-4-11 

< 5 % UT 

(> 95 % dip in UT) 
for ½ cycle 
 
40 % UT 

(60 % dip in UT) 
for 5 cycles 

Not applicable Mains power quality should be that 
of a typical commercial or hospital 
environment. If the use of the 
CADIAX® compact 2 requires con-
tinued operation during power 
mains interrupts, it is recommended 
that the CADIAX® compact 2 be 
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70 % UT 

(30 % dip in UT) 
for 25 cycles 
 
< 5 % UT 

(> 95 % dip in UT) 
for 5 s 

powered from an uninterruptible 
power supply or a battery. 

Power frequency 
(50 Hz/60 Hz) 
magnetic field 
IEC 61000-4-8 

3 A/m 3 A/m Power frequency magnetic fields 
should be at levels characteristic of 
a typical location in a typical com-
mercial or hospital environment. 

NOTE 
UT is the a.c. mains voltage prior to application of the test level. 
 

Immunity test IEC 60601 test level Compliance level Electromagnetic environment -  
guidance 

   Portable and mobile RF communi-
cations equipment should be used 
no closer to any part of the 
CADIAX® compact 2 , including 
cables, than the recommended 
separation distance calculated 
from the equation applicable to the 
frequency of the transmitter: 
Recommended separation 
distance 

Conducted RF 
IEC 61000-4-6 

3 Veff 

150 kHz to 80 MHz 
3 � 1V  in V 

P
V

d ∗






=
1

5,3
 

Radiated RF 
IEC 61000-4-3 

3 V/m 
80 MHz to 2,5 GHz 

3 � 1E  in V/m 
P

E
d ∗







=
1

5,3
  

80 MHz to 800 MHz 

   

P
E

d ∗






=
1

7
 

800 MHz to 2,5 GHz 

   Where P is the maximum output 
power rating of the transmitter in 
watts (W) according to the trans-
mitter manufacturer and d is the 
recommended separation distance 
in metres (m).b 
Field strengths from fixed RF 
transmitters, as determined by an 
electromagnetic site survey,a 
should be less than the compli-
ance level in each frequency 
range.b 
Interference may occur in the 
vicinity of equipment marked with 
the following symbol: 

 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by  absorption and 
reflection from structures, objects and people. 
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a Field strengths from fixed transmitters, such as base stations for radio (cellular /cordless) telephones and land mobile ra-
dios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To as-
sess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If 
the measured field strength in the location in which the CADIAX® compact 2 is used exceeds the applicable RF compliance 
level above, the CADIAX® compact 2 should be observed to verify normal operation. If abnormal performance is observed, 
additional measures may be necessary, such as reorienting or relocation the CADIAX® compact 2. 

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than [V1] V/m. 

9.6.3 Recommended separation distances between portable and mobile RF communica-
tions equipment and the CADIAX® compact 2   

The CADIAX® compact 2 is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of the CADIAX® compact 2 can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile RF 
communications equipment (transmitters) and the CADIAX® compact 2 as recommended below, ac-
cording to the maximum output power of the communications equipment. 

Separation distance according to frequency of transmitter 
m 

Rated maximum output 
power of transmitter 
W  

150 kHz to 80 MHz 

P
V

d ∗






=
1

5,3
 

80 MHz to 800 MHz 

P
E

d ∗






=
1

5,3
 

800 MHz to 2,5 GHz 

P
E

d ∗






=
1

7
} 

0,01 0,12 0,12 0,23 

0,1 0,37 0,37 0,74 

1 1,17 1,17 2,33 

10 3,69 3,69 7,38 

100 11,67 11,67 23,33 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres (m) 
can be determined using the equation applicable to the frequency of the transmitter, where P is the maximum output power 
rating of the transmitter in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by  absorption and 
reflection from structures, objects and people. 

 

9.7 Disposal 

 

After their product life, the CADIAX® compact 2 appliance and its components should be 
disposed of correctly. You should comply with the regulations that are in effect in your 
country or city, regarding the disposal of electronic equipment. 

 

.
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